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Lesson ]
Artificial Intelligence and Ethics of Its Use

—.Lesson,Objectives;:) .

By the end of the lesson, the student will be able to:

1. explain the concept of artificial intelligence and its common
applications.

| 2. explain the role of algorithms in learning artificial intelligence.

. ﬂ Artificialjlntelligencej(Al):;jMachinesaThatyThink! —

Imagine a machine that can think, solve problems, and make decisions
just like you! This is artificial intelligence (Al). It is a technology that enables
machines to use human traits, such as logic, to solve problems.

How do these machines learn? Al relies on something called algorithms.
Think of them as “recipes” or “step-by-step instructions” that the machine
follows to learn and solve problems.

() —
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Lesson.] The Digital Citizen in the Online World

I 2 IArltificiaIIIntelligenceITooIslin|0urlDain|I.-ives:. A

Al is all around us, and you may have already used some of its tools!

3

The tool Its use Example
Face recognition to |Used to verify your identity and unlock your Your
unlock a device phone. smartphone

Digital robots that answer your questions or

. . Siri or Alexa
carry out requests using your voice.

Voice assistants

Tools that prevent dangerous or unwanted Your email

Email filters messages (spam) from reaching your inbox. inbox (Inbox)

Some research
tools or digital
writing

Language Help you draft writings or answers, and send
processing tools |emails or simple messages.

. . Customer
. Windows on websites that reply to you .
Chatbot windows . N " service on some
automatically using “chat robots”.

S websites

I 3 IEthics:IUsing‘ArltificiaIIIntelIigencelResponsiny:. A

Since artificial intelligence is very powerful, we must use and develop it
according to important ethical rules:

1 Inclusivity : Al tools should be inclusive of all users, not just a
select group. Everyone should benefit.

2 Fairness / Avoiding Bias : Al decisions should be based on facts
and data, not on opinions or personal
viewpoints (bias).

3 Privacy : The privacy and security of users’ data must be
protected when designing Al tools. Your personal
information should not be exposed.

Second Term @ -
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The Digital Citizen in the Online World

Lesson. .l

4) Benefit / Usefulness : Al tools should be used to help society
and make it better, not just to gain

personal harmful advantages or to enable
cheating.

Qnits3

) Responsibility :If an Al tool makes a mistake, its designer
should acknowledge the error and fix it.

BracticallActivity)r A

Dear student... by using Microsoft Word or any other word

processing program, write a short essay about artificial intelligence
in our daily lives.

General Questions

\
.ALC_h.o.oAsAe_th.e_c.o.m:e.ct_a.n swer_from_a,_b, c, or d:

1. What is the thing that artificial intelligence tries to imitate in
machines?
A) The speed of a rocket
B) Human traits in problem-solving and logic
C) The movement of clouds
D) Electrical signals in circuits

2. Which artificial intelligence tool is used to protect your email
from dangerous messages?
A) Voice assistants
B) Smart home devices
C) Email filters
D) Smart navigation systems

3. What is the name of the steps or “recipes” that artificial intelligence
relies on to learn and solve problems?
A) Hypotheses B) Algorithms
C) Records D) Statistical models

- ﬂ’@ Primary 6
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Lesson.] The Digital Citizen in the Online World

Unit:3

4. Which ethical principle prevents artificial intelligence from
making decisions based on personal opinions?
A) Benefit B) Responsibility
C) Fairness (Avoiding bias) D) Transparency \

5. What does the principle of “inclusivity” require in Al ethics?
A) The tools are used only by a specific group.
B) The tools are ready to explain how they work.
C) The tools include all users, not just a specific group.
D) The tools are protected from hacking only.

6. Artificial intelligence enables machines to use logicand ______ to
solve problems:
A) handwriting B) decision-making
C) fast travel D) automatic printing

|
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| 7. Which of the following is a common artificial intelligence tool?
| A) A manual sewing machine
|
! B) Navigation apps that guide you to your destination.
' C) A fax machine
| D) A traditional calculator
|
|
|
|
|
|
|
|
I
|
|
|
|
|
|
|
|
|
|
I
|
|
|
|
|
|
|
|
|
|
|
|
|
|

8. The thing that artificial intelligence relies on to learn and solve
problems is called:
A) Records B) Algorithms
C) Clouds D) Metadata

9. Which ethical principle is concerned with ensuring that society
benefits from artificial intelligence?
A) Transparency B) Benefit / Usefulness
C) Responsibility D) Fairness

10. If artificial intelligence collects your personal information, which
principle should it follow?
A) Inclusivity B) Privacy
C) Transparency D) Accuracy

Second Term m -
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The Digital Citizen in the Online World Lesson.l

N

\ Put true (V) if the sentence is correct and false (X) if

QUnits3

B\

\the sentence is incorrect:

1. Artificial intelligence is the technology that enables machines to use
human traits to solve problems. ( )

2. The principle of transparency requires that the tool’s designer be
ready to explain how it works. ( )

3. Language processing tools are the ones that help in drafting
writings and emails. ( )

4. It is ethical to intentionally neglect the data of a certain group of
people when training Al tools. ( )

5. Al tools on social media can suggest people to connect with. ( )

|
- @ Primary 6
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Lesson 2

Online Shopping and Investment -
How to Choose the Best?

’ H .
- Lesson,0bjectives;:y
By the end of the lesson, the student will be able to:

1. explain the concept of e-commerce and the importance of
artificial intelligence in making online purchasing decisions.

2. describe the concept of stocks and bonds and the importance of
investment in supporting companies.

3. identify reliable sources of information and infer the importance
of ethical conduct in investment and purchasing.

AREE - B

. B 1
OIBNTIITT e Il{llh‘lgllﬁirﬁi“
i

E-commerce is the process of selling and buying goods and services over

the Internet. With the growth of online stores and the variety of choices, it has

become necessary to use technology and artificial intelligence to help us make

the right purchasing decisions.
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Qnits3

Online Shopping and Investment — How to Choose the Best? Lesson.2

Dear student, the person who buys goods or services is called a
consumer.

ly Smart Search Engines:

When searching for a specific product, such as a “new school bag,”
search engines use artificial intelligence to analyze your previous data
and preferences. They provide you with:

e Personalized recommendations that match your taste.

e Results ranked according to the most suitable products or the
fastest delivery.

2 Comparison Websites:

These websites help you when buying products, such as electronic
devices, by:
e Comparing several products in one place.

e Evaluating the quality, price, and features of each product to choose
the best one.

3) User Reviews and Opinions:

Before completing a purchase, it is important to know what others
think about the product or service:
e Consumer reviews: Opinions from users, friends, or family online.

e These reviews help evaluate the quality of the product and service
before buying.

- 9 IOnImellnvestment |HowIDo|We|Suppor|tICom-.

Have you heard of the words stocks and bonds? Don’t worry, the
concept is simple !

Stocks,and,Bonds;,:
o 3 pStesteandBondas oy

When you buy stocks in a company, you become a partial owner of
that company. When you buy bonds, you lend money to the company.

- % Primary 6
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Lesson.2 Online Shopping and Investment — How to Choose the Best?

Dear student, stocks are also called financial securities that give you a
share of ownership in the company.

Unit:3

. | At e Lliaa

Why do we do this?
1y To help:

To support companies that we believe provide something good for
the world, such as companies that protect the environment.
2) To make a profit:

The profits or benefits earned by the company are shared with the
investors (stock and bondholders).

_ﬂ IEthicallandISustainablellnvestmenti:- A

It is important to choose companies to invest in that follow ethical
rules, such as:

e Caring for the environment.

e Having transparent and trustworthy management.
e Producing high-quality products.

To ensure this, we should check the companies’ official websites and
evaluate information from reliable sources.

_BracticallActivity): NS\

Dear student... Search the Internet for an example of the
Egyptian Stock Exchange website, then browse the site and write

a report about it in terms of: (You can ask your teacher or a family
member for help)

o}

e Market summary.
¢ Indicators summary.
e Statistics.

- J

Second Term ﬂ@ -
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Online Shopping and Investment — How to Choose the Best? Lesson.2

General Questions

Qnits3

|
|
|
|
|
[

| \
¥ Choose_the_correct_.answer_from_a, b, c, ord:

) 1. What is the process of buying and selling goods and services
online called?
A) E-commerce B) Digital investment
C) Traditional marketing D) Cloud comparability

2. What do smart search engines use to provide personalized
suggestions and rank products based on user relevance?
A) Font size B) Artificial intelligence
C) Page design D) Calculator

3. When you buy a share in a company, what do you become in
relation to that company?
A) A lender
B) A consumer
C) An employee
D) A partner

before investing in it?

A) To confirm the company logo’s color.

B) To stay updated on new products.

C) To know the number of company employees.

D) To verify the ethical rules followed by the company.

5. What is the function of online comparison websites?
A) To hide product prices.
B) To compare product specifications and prices in one place.
C) To remove unwanted products.
D) To collect ratings only from friends and relatives.

6. E-commerce is the buying and selling of goods and services

through:
A) The Internet B) Regular mail
C) Traditional market D) Libraries

|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
! 4. What is the importance of reviewing a company’s official website
|
|
|
|
|
|
|
|
I
|
|
|
|
|
|
|
|
|
|
|
|
|
|
I
|
|
|
|
|
|
|
|
|

|
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Lesson.2 Online Shopping and Investment — How to Choose the Best?

7. What are the securities that give you an ownership stake in a
company called?
A) Bonds
B) Sukuk
C) Shares
D) Vouchers

8. Which technological tool helps you compare prices and
specifications when buying a mobile phone?
A) Traditional search engines
B) Shopping websites
C) Online comparison websites
D) old apps

9. What should an investor consider when choosing companies to
support the environment?
A) Profit maximization only
B) The company is very large.
C) The company is environmentally friendly and follows ethical rules.
D) The number of employees

10. Why has the importance of using technology increased in
making purchase decisions online?
A) To reduce the number of available options.
B) Because the number of options and products has become very
large.
C) Because stores have become closed.
D) To make traveling easier.

11. Which of the following is one of the most important artificial
intelligence tools that helps a user on the Internet?
A) Using a calculator
B) Smart search engines
C) Writing by hand

|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
: D) Listening to music
|

|

|

|

|

Second Term
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Online Shopping and Investment — How to Choose the Best? Lesson.2

12. The person who buys goods and services is called:
A) Designer
B) Programmer
C) Consumer
D) Developer

Qnits3

13. Investing in a company’s bonds means that you:
A) Receive free goods from it
B) Lend the company an amount of money
C) Own all the company’s shares
D) Consume all the company’s products

14. Investing in a company’s shares should be for the purpose of:
A) Wasting money
B) Cheating others
C) Supporting the company and making profits
D) Trading personal data

15. What do smart search engines use to rank the results that suit
you?
A) The color of products
B) Your preferences and previous browsing behavior
C) Store names

|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
. D) Advertisement images
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
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Lesson 3

Digital Communication

LessonObjectives;:y

By the end of the lesson, the student will be able to :

1. identify educational service providers and support services.

2. explain the role of email and chatbots in communicating
accurately and respectfully.

3. mention other means of communication over the Internet.

ﬂ Who provide;‘. usiwithisupport;senvices}:]

When you need help with séfhi’rig}l 'v—\-llﬁe'fh'er it is a technical problem or
a question about your studies, there are people and organizations ready to

provide support.

Educational Service Providers (ESP): These are organizations that offer

various educational services for students and teachers. They may provide bo

Second Term
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or online training materials. For example, the Alexandrina Library may assist
you in this area.

Qnits3

1y Customer Support Services:

These are services provided by companies to help you solve problems or

— answer your inquiries.
2y E-mail communication:

E-mail is a formal and professional means of communication. [If your
problem needs a long explanation, or you want an official document,
email is the best option to communicate in the following situations:

e |f your problem needs a long explanation.
¢ |f you want an official document.
3 Tips for Writing an Email:

a. Clear Subject: Write a clear and concise subject line for your email so
the recipient knows the purpose of your message.

b. Communicate Respectfully: Begin the email with a formal and polite
greeting (e.g., “Dear...”).

c. State Your Purpose: Clearly mention the reason for your communication
and the information you need (e.g., “Dear Student...”).

S 2 -Chatbotslz-

Sometimes, you may visit a website and see a small window that asks:

“Hello, how can | help you today?” These are (chatbot).

e What are they? They are programs that use artificial intelligence
technology and are designed to answer questions directly over the
Internet.

e Speed: They provide quick responses, and service providers can
usually reply within 24 hours if human assistance is needed.

e Accuracy: Since they are robots and not real people, it is important
to express your request clearly and precisely. If your questions are
unclear, you will not receive accurate answers.

- 2@ Primary 6
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ERNPPSNCSRMIMSY  DigiaiCommunicaton NN
Communicatingglhrough,Other,Means;:
I e S |\

In addition to email and chat, you can communicate with service

Unit:3

providers through:

e Phone support windows: Talking directly with a support staff N
member.

e Visiting support offices: Going to the organization’s office to submit
your request.

~BracticaljActivityy:; RVAN o

Dear student... Conduct a search on the Internet to review

the most important applications used for secure communication
online (you can ask your teacher for help).

- J

General Questions

\
.A;C_h.o.os.e_the_con:e.c‘t_an swer_from_a, b, c, or_d:

1. What is the name of the organizations that provide support to
students and teachers in the field of education?
A) Educational Service Providers (ESP)
B) Public transportation services
C) Retail companies
D) Sports training centers

2. Why is it important to have a clear subject in the email?
A) To increase the size of the message.
B) To change the font color.
C) To let the recipient know the purpose of the message.

D) To add images.
Second Term @ -
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Digital Communication Lesson.3

3. What is the name given to Al-powered chat programs on

Qnits3

websites?
A) Voice assistants B) Navigation apps
C) Email D) Chat windows (Chatbot)

/ 4. Why should your questions be precise and clear when using a
chat window?
A) To take more time. B) To reduce Internet usage.
C) To speed up the device. D) To get accurate answers.

5. What is the first step you should take when writing the content
of an email?
A) Start with a formal and respectful greeting.
B) Write the attachments.
C) End the message with your signature.
D) Add images.

6. Email is considered a means of communication:
A) informal B) random
C) formal D) personal only

7. If your problem requires a very quick response, what is the best

option?
A) Sending a fax B) Traditional email
C) Chat window D) Writing letters
8. What do chat windows use to understand users’ questions?”
A) Al-powered programs B) Calculator
C) Hard drive D) Browser
9. Which part should you specify the purpose of your email from the
beginning?
A) Email signature B) Beginning of the greeting
C) Email body D) Email subject

10. Mention one advantage of chat windows compared to email:
A) More formal
B) Instant response
C) Suitable for explaining long problems
D) Difficult to use

|
- 22 Primary 6
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Lessons.__ (T

b= . . .
' \ Put true (l/) if the sentence is correct and false (X) if
~ lthe sentence is incorrect:

Unit:3

1. The best way to communicate if you need a detailed and professional \
explanation of a problem is email. ( )

2. Chat windows are always the best way to communicate about
complex problems. ( )

3. Online consumer reviews are a helpful tool for evaluating the quality
of a product before purchase. ( )

Y. Social media messages are always the most suitable way to provide
accurate and professional information. ( )

5. The most important element to enable the recipient to quickly
identify the purpose of an email is the email subject. ( )

e e e = = = ———— ————————————— — —

Second Term @ -
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Lesson 4

Video Conferencing

—.LessonObjectives;:} .

By the end of the lesson, the student will be able to :

1. explain the concept of video conferences and their most popular
programs.

2. describe the steps to create and join a conference, including
checking devices and connection.

3. mention the follow-up actions after the conference, such as
‘ follow-up or recording.

(2 —
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Lesson.A—— . T

— ] gaWhat,are,video,conferences;:

Unit:3

Imagine you are talking to your friend or teacher and can see and hear them,

but each of you is in a different place! This is what video conferences are!

Video conferences are tools that allow people in different locations to N
communicate with each other using voice and video in real time. This is similar
to direct interaction, but over the Internet. They are conducted via cloud
computing.

Populargvideo,conferencing,tools;:
I I e U N

Many organizations use video conferences for different purposes (such
as studying or work). Some of the most popular programs are:

e Google Meet
e Microsoft Teams
e Zoom

— 3 .Stepslto|Use|Video|Conferences|:_

When you or your teacher want to start a meeting or join one, there
are simple steps you can follow:

First: Create a New Meeting:
a. Click on the “New Meeting” option.

b. Choose the option that suits you (an instant meeting or scheduling
a meeting for later).

c. After creating the meeting, you will find the meeting link. Copy it
and share it with the people you want to join.

Second: Joining a Meeting:
To join a meeting that someone else invited you to, you can do one of
the following:

a. Click directly on the link that was sent to you.
b. Copy the meeting code or link, paste it into the designated field, and

then click the “Join” button.
Second Term % -
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Video Conferencing

Lessond_____

o
g [T Important,Rules,Before,,During,,and,After,

To make your meeting successful and effective, follow these guidelines:

Before the Conference:

[,

Check the technology:

e Make sure the internet is working well and that the camera and
microphone are functioning correctly. This will help you avoid
technical problems that could disrupt the meeting.

2 During the Conference:

e Manage audio and video: Once you join, you can click the
microphone icon to mute or unmute yourself, and the camera icon
to turn your video on or off.

e Stay calm and professional: Make sure your behavior is appropriate
for the meeting. Watch the screen attentively and use the camera
or microphone only when necessary.

(7Y

After the Conference:

Follow-up and recording: You can send a follow-up email. If the
meeting settings allow, you can also access a recording of the
meeting.

~BracticaljActivityy; RVAS °

Dear student... design a poster that highlights the importance
of using video conferencing tools such as Google Meet and
Microsoft Teams.

- J

- Primary 6
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Lesson.4—— . TSI

General Questions

Unit:3

]

|

|

|

|

L

| \

/A Choose_the_correct_answer_from_a, b, c, or_d:

|
1. Video conferences allow communication between people in
different locations? —_—
A) Only written text messages B) Only still images

C) Voice and video at the same time D) Email

2. What is the first step you take when you want to create a new
video meeting?
A) Send an email B) Click on “End Call”
C) Share the screen D) Click on “New Meeting

3. What is the necessary step you should take before joining a
conference to avoid technical problems?
A) Have breakfast.
B) Check the internet connection and ensure the camera and
microphone are working.
C) Write a long message.
D) Update the operating system.

who created the meeting?
A) The street name where you live B) Phone number
C) The meeting link or join code D) Email address

5. What is the technological environment in which video conferences
take place and that allows using applications remotely?

A) Memory card B) Personal computer
C) Cloud computing D) Hard disk

6. Video conferences allow you to communicate in the same
A) time B) only the next day
C) only the past week D) only next month

7. If you want to join an ongoing meeting and you don’t have the
link, what can you use instead?
A) Your email B) The meeting code
C) Store name D) Phone number

Second Term @ -
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Video Conferencing Lesson.4

| 8. What is the process that allows you to get a copy of the meeting
after it ends?

Qnits3

A) instant chat B) Joining the meeting

C) Screen sharing D) Recording the conference
/ 9. What is the function of the ‘Join’ button in video conferencing

programs?

A) Enter the meeting. B) Create a new link.

C) Turn off the camera. D) Share the screen.

10. Mention a type of digital tool used in video conferences:
A) Word B) Google Meet C) Excel D) Paint

N\

B\‘ Put true (V) if the sentence is correct and false (X) if
~ Jthe sentence is incorrect:

’

1. To create a new meeting, you should click on the “New Meeting’
option. ( )

2. If you are a participant, you should turn off the camera and
microphone when you do not need to use them at the moment.

( )

3. conferences allow real-time written communication. ( )

4. The email sent after the conference is called a follow-up email.

( )

5. Inappropriate behavior during a video conference is considered
improper and should be avoided. ( )

droule’ &1iSo panig usi
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Lesson 5

Programming Languages and Solving
Digital Problems

Lesson|Objectives;:}
By the end of the lesson, the student will be able to :
1. recognize programming languages and their importance in
creating web pages.

2. identify the steps to solve technical problems, such as file
‘ corruption or charging issues.

3. explain ways to protect files from loss and ensure secure storage.

- 4
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- 1 IPIrogramminglLanguaEésleo’w"/ IDB(// I\Ne I'I'alk |to.

Did you know that computers have their own language? These languages

are called programming languages.
o

Programming languages are a set of rules and symbols that we use to give
clear instructions to computer programs.

Second Term @ -
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Programming Languages and Solving Digital Problems Lesson.5

- 2 .MostlPlopular|Web|PlrogramminglLanguages:-

e HTML (HyperText Markup Language): This language is used to
build the structure of web pages. Think of it as the “skeleton” that

/ forms the body of the page.

e JavaScript: This language is used to create interactive and dynamic

web pages, such as moving buttons or pop-up windows. It adds

“life” to the page.

I 3 IGommonIDigitalIPlroblemslandIHow'toISoIvelThem:. :

In the world of technology, it is natural to encounter some problems.

Some of the most important of these problems are:

The problem The Suggested solutions (steps)
1. Make sure the file is what you expect it to be.
. 2. Try opening it with a program other than the one you are
Corrupted File v op g. prog Y
currently using.
3. Ifyou are sure, it is corrupted, delete it to avoid problems
1. Make sure the charging cable is working properly.
Device Not 2. Ensure that the electrical socket or adapter is functioning
Charging properly.
3. You may need to replace the battery if the problem is with it.
1. Click on the link that says you forgot your password.
TR PR 2. Follow the steps to create a strong password.

Ways to Save Files

It is always best to make a backup. You can save the file on an
external drive, or preferably, on a cloud storage service (such as
Google Drive or OneDrive).

File Cannot Be

Check that the file may contain special characters. These characters

\ Deleted may restrict Windows and make it difficult to delete. y
BracticalfActivity): 2% o

Dear student... With the help of your teacher, identify some

potential malfunctions in computers and suggest solutions for

them.

- @@ Primary 6
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Lesson.5 Programming Languages and Solving Digital Problems

Unit:3

General Questions

\
=_ Choose_the_correct_.answer_from_a,_b, c, or_d:

1. Which programming language is used to create the basic structure
of web pages?

A) JavaScript B) Excel C) HTML D) Paint
2. If your device is not charging, what is the first thing you should

check?

A) Device volume B) Date

C) Internal battery D) Charging cable

3. Which language adds interactivity and movement to web pages?
A) HTML B) JavaScript C) Paint D) Excel

4. What is the best option to permanently protect files from loss?
A) Save the file in the Recycle Bin.
B) Save it on the desktop.
C) Save it on a USB drive.
D) Save it on cloud storage.

5. What is the final step you should take if all attempts to fix a
corrupted file fail?
A) Try opening it with different programs.
B) Delete the corrupted file.
C) Send the file to a friend.
D) Restart the device.

6. Programming languages are symbols and rules that give to
the computer:
A) instructions (or commands) B) still images

C) songs D) animated images

7. What is the problem called when a file is unusable?
A) Regular file B) Corrupted file
C) Saved file D) Temporary file

Second Term @ﬂ’ -
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Programming Languages and Solving Digital Problems Lesson.5

8. HTML creates the structure of a page, so what does JavaScript add

Qnits3

toit?
A) Structure only B) Special attributes
C) Interactivity and motion D) Text only
— 9. What type of storage allows you to save your files on the Internet?
A) Cloud storage B) Recycle Bin
C) Internal hard drive D) External hard drive

10. In your opinion, why should passwords be strong and unique?
A) To protect the account from hacking.
B) To make them easy to remember.
C) To be short.
D) To make sharing with others easier.

N\

\ Put true (V) if the sentence is correct and false (X) if

\
\the sentence is incorrect:

1. If the message “File corrupted” appears, it means the keyboard is not
working. ( )

2. JavaScript is used to create only static web pages. ( )

3. The best way to permanently protect files from loss is to save them
on cloud storage. ( )

4. If you forget your password, you should guess it until it works.

( )

5. When trying to delete a file that cannot be deleted, you should

|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
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r-
|
|
|
b
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
I
|
|
|
|
|
|
! check whether it has special attributes. ( )
|

|

|

|

|

|
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|

|

|

|

|

|

|

|

|

|
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Lesson 6
Image Editing

Lesson,Objectives;:} .

By the end of the lesson, the student will be able to :

1. identify the GIMP program and the goals of image enhancement.
2. list the capabilities of image editing and integrating them into
presentations.

3. explain the role of artificial intelligence in image enhancement :
and color organization. )

Do you have a photo you took that has strong light or unnatural colors?
You can fix that through “image editing”.

Image editing is the process of changing and adjusting images to make
them look more attractive and appealing. The goal may be to correct an
error in the image or to make it look professional for presentations.

Second Term m
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Image Editing Lesson.6

I 2 Image,Editing,Programs,(like,GIMP):

Qnits3

We use powerful programs to editimages. GIMP (short for GNU Image
Manipulation Program) is an excellent example:

) e Features: It is an efficient, open-source program. This means you
can use it for free and customize its tools.

e Usage: You can download it directly from the Internet.

What can we do in image editing?

Image editing gives us many capabilities:

1. Correcting imperfections: You can restore colors to their original
state or remove excess camera light.

2. Changing colors: You can change the color of an image or video
background. For example, you can adjust the color tone of a video
frame to make it smoother .

3. Merging images: You can combine two different images into one.
This is very useful when creating presentations.

4. Special effects (filters): You can use filters to make an image look
old or to add “motion blur”, which gives a visual effect to moving
objects or videos, making them appear blurred or streaked in the
direction of motion.

Artificial,Intelligence,Helps,You,!
I e i A - /.

In modern image editing programs (like GIMP), artificial intelligence is
used to assist you:

e Color organization: Artificial intelligence learns how to adjust the
colors in an image so that only the colors you need appear.

BracticalfActivity;:; 2% o

Dear student... through using the Internet, search for free and

open-source image editing programs. Then compare the features
of each program.

- @é}' Primary 6
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Lesson.6 Image Editing

Unit:3

i General Questions

3

PR
¥ Choose_the_correct_.answer_from_a, b, c, ord:

1. What is the main purpose of image editing?
A) Changing images and making them look more attractive.
B) Reducing image clarity.
C) Making images always look old.
D) Increasing file size.

2. What is the name of the process that makes two different images
appear as one image in a presentation?
A) Color correction B) Background change
C) Image merging D) Image cropping

3. What is the role of artificial intelligence in image editing software?
A) Deleting old files
B) Printing the image
C) Organizing and customizing colors
D) Increasing camera resolution only

4. Why is the GIMP program considered “open source” ?
A) Because it is not free.
B) Because it allows users to modify its tools.
C) Because it is used only online.
D) Because it cannot be installed on a device.

5. Mention a defect that may appear in an image and can be corrected
by editing “other than color”:
A) Blemishes or excessive camera light B) Slow internet
C) Low video sound D) Difficulty typing

6. Improving images means correcting and restoring the
colors to their original state:
A) the background B) the lighting

C) blemishes D) the size

Second Term
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Image Editing Lesson.6

7. If you want to make your image look old or have motion blur, what
can you use?

Qnits3

A) Text editing B) Color organization

C) Special effects (filters) D) Background removal
— 8. You can to use them in your presentation?

A) merge images B) increase internet speed

C) change text color D) write comments

9. What does using GIMP require from the user?
A) Taking enough time to learn and practice
B) Purchasing the program
C) Being a professional artist
D) Having fast internet

10. What is another name given to special effects in image editing

software?
A) Filters B) Colors
C) Attachments D) Shapes

N

B\‘ Put true (V) if the sentence is correct and false (X) if
~ lthe sentence is incorrect:

1. To make an image look like it is moving or has motion blur, we use
special effects (filters). ( )

2. Two images can be merged to become one through image editing.

( )

3. The role of artificial intelligence in image editing software is to
organize and customize colors. ( )

4. The famous program used as an alternative to GIMP is Microsoft
Word. ( )

5. If there is a defect or blemish in the image due to camera light,
image editing helps correct it and restore it to its original state.

i ( )
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Lesson |

The Role of Information Technology in
Improving Our Lives

—Lesson|Objectives;:} .

By the end of this lesson, the student will be able to:

1. analyze the role of information technology in protecting the
environment and improving daily services.

2. explore smart transportation tools and compare them with
traditional methods.

3. design a prototype of a technological tool to solve a local
transportation problem.

(35 J—

Go Lo $hgl ada Juoai i
droule’ &1iSo panig usi
djala DS Gulaig pége



Lssonli

Information and Communication Technology (ICT): A
Force for Change

Qnit’ 4

Dear student, Did you know that the smartphone you carry is not just
for communication, but is a powerful tool for solving real-world problems? \
Information and Communication Technology (ICT) is an abbreviation for all the
technological tools that help us process information.

ICTgand;a;BettergEnvironment
] M/\/\_o

Technology helps us build a better environment through:
1y Clean Vehicles:

ICT applications and payment systems have helped the spread of electric
vehicles. These vehicles do not emit harmful exhaust, reducing pollution
and protecting our health.

2 Energy Conservation:
Technology helps us manage energy consumption in homes and factories
intelligently, reducing resource waste.

3 Increasing Job Opportunities:
Technology helps us manage energy consumption in homes and
factories intelligently, reducing resource waste.

2 ICT and,FastergServices;(Online;Bookin
I e e’ [\

Online booking is when you use websites or apps to request and reserve a

service or appointment without having to go to its location. This saves your
effort and helps you organize your time.

How Do These Tools Work?

e Global Positioning System (GPS \,93):
It is the foundation of any smart transportation system. It accurately

determines your location and the location of the vehicle, and suggests the
best and fastest route.

e« Smart Applications :
Such as taxi booking apps or train ticket booking apps. These applications
provide electronic payment options and show you the cost before you start.

Second Term @ -
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Lesson.1

e Notifications and Reminders:
They send you alerts about the arrival time of your transportation or
reminders for your bookings, helping you avoid waiting.

a-
3 mInnovation Challenge:gDesigninggang|CT,
_‘ jToolkto)Solve)afTransportation ,
Imagine yourself as a technology engineer responsible for solving a
transportation problem in your area :

Comparison|Between o Technological/Solutions
Traditional/Methods/and TraditionaliMethods T
[~ “Technological/Solutions T T (Esing ) ]
Waiting at the bus station Use a tracking app (GPS)
The problem without knowing its arrival | to know its location on the

time. map.

Paying cash to the driver,
Payment which may risk losing
money.

Use electronic payment via
phone, which is safer.

Wasting time and
Result being exposed to traffic

Save time, reduce pollution,

and increace cafetv J

RracticallActivity):; /\/\ o

Dear student... Create an illustrative diagram using one of the
office software programs to show how information technology
contributes to our lives. Add icons and images to make the diagram
attractive and easy to understand.

- J
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Lscont

General Questions

Qnit’ 4

rAlLC.ho.os.e_th.e_com:ect_answ.e.r_fnom_a,_b,_c,_oAr_d:‘

1. What is the main component used in online booking applications
to determine locations? —
A) Cooling system B) Cash payment system

C) Global Positioning System (GPS) D) Solar power system

2. Information and Communication Technology contributes to a
better environment by:
A) Increasing the number of gasoline-powered cars
B) Neglecting public transportation
C) Reducing the number of computers
D) Supporting the use of zero-emission vehicles

3. One of the benefits of online booking in daily services:
A) Saving time and effort B) Increasing waiting time
C) Excessive use of paper D) Complicating procedures

4. If a flight booking app sends you a message to remind you of
your departure time, this service is called:
A) Automatic notifications B) Central heating
C) Photography D) Smart lighting

5. Which of the following terms stands for “Information and
Communication Technology”?
A) GBT B) ABC O ICT D) CPU

6. Which of the following is a traditional problem solved by an
online booking system?
A) Sitting at home B) Using the phone
C) Standing in a long queue D) Browsing the internet

7. When you use an app to find the location of the school bus, you
are exploring the types of ICT tools used in:
A) Building houses B) E-learning
C) Modern agriculture D) Smart transportation system

Second Term ém’ -
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Lesson-]

| 8. If a transportation company relies on electronic payment instead
of cash, this increases:

A) Safety B) Pollution C) Fuel consumption

D) Breakdowns

QUnit’H

) 9. The tool that helps the driver know the best route to avoid traffic
is part of the system:
A) Central cooling B) Navigation and routing
C) Entertainment D) Smart lighting

10. The purpose of proposing the design of a new technological tool
is:
A) Ignoring problems
B) Making manual work more difficult
C) Innovating smart solutions for problems

|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
| D) Increasing complexity
|

N

" Put true (l/) if the sentence is correct and false (X) if

.
|
|
= ‘the sentence is incorrect:

1. You can book a doctor’s appointment online without
needing to visit the clinic. ( )

2. Technology contributes to increasing carbon emissions in the
environment. ( )

3. The school bus tracking app helps the student organize
their time and arrive on time. ( )

4. Proposing a new idea for designing an app is a type
of innovation. ( )

5. There is no difference in time or effort between

|
|
|
|
|
|
|
|
|
|
|
|
|
|
I
|
|
|
|
|
|
|
|
|
|
|
|
|
: traditional booking and online booking. ( )
|

|

|

|

|

|

|

|

|

|
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Lesson 2

Working with Operating Systems and
Computer Applications

Lesson|Objectives;:} \

By the end of the lesson, the student will be able to:

1. explain the concept of an operating system and give examples of
its different types in computers and smartphones.

2. describe how to change system settings to suit user needs.

3. identify the steps to install software and applications within the
operating system

An operating system is the software that makes a computer work. It is

responsible for running various programs such as games, word processing

software, and design programs. Without an operating system, a computer

Second Term m
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Working with Operating Systems and Computer Applications Lesson-2

Examples of operating systems:

QUnit’ 2

@ Windows =- (Microsoft) G
@® MmacOS (Apple) "

@ Linux @

_J ® Android and iOS (for smartphones and tablets)

An operating system helps you to:
@® manage files and folders.
@ run different programs.

@ control hardware components such as the screen, mouse, and keyboard.

2. Changing;System;Settings;:
T pShengmsy 2

You can modify device settings through the Control Panel in Windows or

through Settings on phones. Some settings that can be changed include.

Changing the desktop/background wallpaper:

@ Adjusting the volume level
® Changing the language, date, and time
@ Connecting to the internet (Wi-Fi)%=®

Be careful when changing settings to avoid affecting device operation.

3 Installing;Software;and;Applications;:
R bsesetdeendt aaeeeenddd  \_

Software consists of tools that help us perform specific tasks, such as

writing, drawing, or learning.

@ To install software on a computer, it can be downloaded from the internet

or from a CD 'O , and then follow the installation steps.

® On smartphones, applications are downloaded from app stores, such as:
® Android devices: Google Play Store '
@ iPhone devices: =- App Store

After installation, the application icon appears on the screen and can be

opened by clicking on it.

- % Primary 6
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Lessonz2 Working with Operating Systems and Computer Applications

BracticallActivity): AS\ .

Dear student... Add or install some safe applications on mobile

Qnit’ 4

devices (you can ask your teacher or one of your parents for help).

General Questions

r

PR
‘A Choose_the_correct.an swer_from_a,_ b, c, or_d:

|
1. Which program makes a computer work?

A) Drawing program

B) Operating system

C) Word processing program
D) Electronic game

2. Examples of operating systems for phones:

A) Windows only B) Linux
C) Android and iOS D) Mac
3. To change the wallpaper, we use:
A) Keyboard B) Control Panel
C) Recycle Bin D) Browser
4. The app store on Android devices is called:
A) Word Store B) Play Store
C) Windows Store D) Apple Store
5. Changing the language and date from system settings helps in:
A) Improving sound B) Organizing device usage
C) Deleting files D) Installing software

6. Which company developed the Windows operating system?
A) Google B) Apple C) Microsoft D) Linux

7. Which of the following is not an operating system?
A) Android B) Facebook C) Windows D) Mac

Second Term é?) -
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QUnit’H

Working with Operating Systems and Computer Applications Lesson-2

8. What is the function of an operating system?

A) Running games only

B) Running the device and managing programs
C) Displaying images only

D) Increasing internet speed

A) Recycle Bin B) App Store

C) File Manager D) Settings
10. When adjusting the device’s volume, we use:

A) Printer B) Microphone

C) Settings D) Recycle Bin

|
|
|
I
|
|
|
|
|
|
|
:
|
| 9. Where can applications be downloaded on a phone?
:
|
|
|
|
|
|
:
:
:
|

N\

\ Put true (V) if the sentence is correct and false (X) if

)
B8 .
- \the sentence is incorrect:
1. The operating system used in Apple mobile devices is iOS. ( )
2. To change the device language, we go to the App Store. ( )

3. The operating system on a computer is responsible for running
programs and organizing the device. ( )

4. The application store for iPhone devices is called the Play Store.( )

5. When installing a new program on a computer, the installation
steps must be followed. ()
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] W |

Lesson 3
Preparing and Sharing Reports

Lesson|Objectives;:j \

By the end of the lesson, the student will be able to:

1. identify the importance and tools of the Word program.
2. insert images and tables into a document.

3. use messaging applications safely and responsibly

Microsoft Word mg is considered one of the most popular word processing
programs in the world.
The program helps you write reports, format them, and add images, tables,

and headings, making documents well-organized and easy to read.

Second Term @ -
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Preparing and Sharing Reports Lesson-3

Program Interface Components:

QUnit’H

When you open Microsoft Word, the following appears:

@ Menu Bar : It contains commands such as File , Insert , and
Layout -’ —
— @ Toolbar : It includes buttons for formatting text, such as changing

the font color or font size.

® Writing Area : The space where you type the report.

Steps to Write a Simple Report:
1 Open Microsoft Word @
Choose “New Document”.
Type the report title, such as: "Artificial Intelligence in Our Lives".
Add text and images through the Insert menu.

Format the text using the tools on the top toolbar.

Cad Gl d 1

Save the file with a suitable name by going to File puis Save l:" .

2L Messaging;Services
___CUESRILESTES SN

Messaging services such as WhatsApp (OF Messenger 0 and Telegram
4 help us exchange messages, images, and files quickly and easily over the

Internet.

Tips for Using Messaging Safely:

® Do not share your personal information with strangers.
@ Do not open strange or unknown links.

® Use messaging for useful purposes, such as studying or communicating
with friends and teachers.

@ Respect others in your messages, and avoid spreading rumors.

Practical A‘ct‘vit’y):j /\/\

Dear student... With the help of your teacher or a family member,

O

use one of the messaging applications such as WhatsApp or

Telegram. Then, write a short report about some of its features.

\ J
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! GeneralQuestions
|

[

| \
:.ALC.ho.os.e_th.e_c.o.m:e.ct_a.n swer_from_a,_b, c, or d:
|

Qnit’ 4

1. Which program is used to write reports?
A) Excel B) PowerPoint C) Word D) Paint —_—

2. The command used to insert an image into a document is:
A) File B) Insert C) Layout D) View

3. The writing area in Microsoft Word is the place where:
A) We change the language B) We write text
C) We save files D) We display images only

4. An example of a messaging application is:
A) Word B) WhatsApp C) Excel D) Paint

5. To protect yourself when using messaging applications, you
should:
A) Share your phone number with everyone
B) Open all links
C) Not share personal information

D) Ignore privacy settings

6. A table can be inserted in Microsoft Word from the:
A) Insert B) File C) View D) Tools

7. One of the tools that helps in formatting text is:
A) Changing the color B) Deleting the program
C) Adjusting the clock D) Playing sound

8. To save a file, we choose the command:
A) Open B) Print C) Save D) Exit

Second Term -
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Preparing and Sharing Reports Lesson-3

| 9. One of the messaging services that allows sending images is:
A) Word B) WhatsApp C) Paint D) Excel

QUnit’H

10. One of the safe ways to use messaging applications is:

A) Sharing passwords
B) Not respecting others
C) Using the application for useful purposes

D) Opening unknown links

N

B\\ Put true (V) if the sentence is correct and false (X) if
~ Jthe sentence is incorrect:

1. Microsoft Word is used for word processing and writing reports. ()
2. To save a document in Microsoft Word, we use the “Insert” menu.( )

3. Images can be inserted into a document through

the “Insert” menu. ()
4. An example of messaging services is the Excel application. ()

5. One of the safety rules in messaging is not opening

|
|
|
|
|
|
|
|
|
|
|
|
I
l
|
|
|
|
|
|
|
L
|
|
|
|
|
|
|
|
|
|
|
I
l
|
|
|
|
:
|
|
| suspicious links. ()
|

|

|

|

|

|

|

|

|

|

I

l

|

|

|

|

|

|

|

:

:
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Lesson 4

Creating Presentations

y ‘e [ 3% o
- LessonObjectives:)
By the end of the lesson, the student will be able to:
1. explain the importance of presentations and the PowerPoint
program.

2. identify the basic tools in the PowerPoint program interface.

3. design an attractive presentation using animations, graphics, and
shapes

CREATIN
PRESENTATIONS

. aaaia D

o Lilzo GligVl a2m Jioai pi
droale’ d1iS0 panig pusi
ajaly hSio Fulaig pige



lissorialé’
. .WhatiAreIPI resentations?_ A

Have you ever thought about how you can present your ideas or research

it

results to your classmates and teacher in an interesting and enjoyable way?

—

This is what is called a presentation.
Dear student,

A presentation is a set of slides that you use to present information and ide-
as. It helps you deliver your message clearly and attractively by using text, im-
ages, shapes, and animations. Imagine that you are telling a story using moving

pictures and music! this is the secret behind successful presentations.

e IMicrosoftiPlowerPloint:IYourIPlarltnerlinICreativity. A

The most popular and easiest program for creating presentations is Microsoft
PowerPoint ﬂt This program is part of the Microsoft Office @ suite, which

you often use at school and at home.

PowerPoint has very easy tools, such as drawing and writing tools, and many
animation options that make your slides appear and move in an attractive and

enjoyable way.

Idea:
]

Using PowerPoint makes you like a creative director who creates a short

movie for their ideas!

Basic PowerPoint Tools: Let’s Explore the Program!

When you open PowerPoint, you will find an organized interface that makes
your work easier. Here are the most important areas and tools that you will

need.

- 5@ Primary 6
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#
Tool Name Its!Location]in the Its|Function :
B T Program T ]
. Top left or right It is used to save the presentation
File Tab . .
. (depending on the (Save), open a presentation (Open),
(File) S .
program language) or print it (Print).
Home Tab It contains important formatting —
(Home) At the top of the program | commands such as changing the

font size, font type, and font color.

At the top of the screen
Tabs (such as Design, Insert,
and Animations)

Each tab contains a group of
specialized tools.

We choose from it, the slide
size to format the slide layout,

Design Tab
(Design) One of the main tabs and to select a theme to change
the background and colors for a
beautiful design that suits your
topic.
Insert Tab We use it to add new elements to
(Insert) One of the main tabs the slide, such as images, shapes,
charts (to explain numbers), and
videos.
Review Tab It is responsible for checking words
. One of the main tabs and ensuring that there are no
(Review)

spelling errors. )

Using these tools, you can turn your ideas into a visually attractive and per-

suasive presentation!

RracticallActivityj: AN
Dear student... Design a presentation on one of the following

topics (The opening of the Grand Egyptian Museum, Ways to
protect the environment, Awareness of the dangers of the Internet)

Second Term -
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I °
! General Questions
|
[
:I.A;C_h.o.os.e_th.e_c.o.ltt:e.ct_a.n swer_from_a, b, c, or_d:
1. Which program is the most popular and commonly used to create

QUnit’H

presentations?
A) Word B) Excel C) PowerPoint D) Paint

2. A presentation is used to:
A) write long messages
B) perform mathematical calculations
C) present ideas and information in an engaging way
D) browse the Internet

3. To add a new image to a slide, we use the tab:
A) Animations B) Design C) Insert D) View

4. If you want to change the shape and color of the entire slide
background, you will use the tab:
A) File B) Insert C) Review D) Design

A) spell checking and ensuring word accuracy
B) adding charts

C) formatting fonts and colors

D) creating transition animations

6. Which tools can you use to create an attractive and eye-catching
visual presentation?
A) Cooking tools
B) Easy tools such as animations, shapes, and images
C) Knitting tools
D) Sculpting tools

7. In PowerPoint, the bar that contains commands such as changing
the font size is:
A) file tab B) task bar (Home tab)

|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
I 5. The main function of the “Review” tab is:
|
|
I
|
|
|
I
I
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
i C) status bar D) animations bar
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| 8. Before you start designing slides, you can set the slide size using

Qnit’ 4

| the option:
A) Slide Size B) Background Color
C) Font D) Insert Table
9. Transition effects between slides help you to: —

A) Print the document

B) Save the file

C) Make your presentation more exciting and lively
D) Send an email

10. What is the element you should maintain to ensure a successful
presentation?
A) Using a lot of text only
B) Ignoring images
C) Delivering your idea effectively and impressing the audience
D) Using one font throughout the presentation

N\

B\\ Put true (V) if the sentence is correct and false (X) if
~ _Jthe sentence is incorrect:

1. Charts are used in PowerPoint to explain complex data
and numbers in a simple way. ()

2. A theme in PowerPoint means inserting an image into
the slide. ( )

3. The “Animations” tab is used to add visual effects
to elements on the slide. ()

Y. Slides in PowerPoint are the spaces where we write
text and add images. ()

5. One of the most important skills for using PowerPoint
effectively is the ability to deliver the idea and impress the audience.

()
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Lesson 5

Databases Using Excel

—Lesson|0bjectives;:j
By the end of the lesson, the student will be able to:
1. identify the concept of databases and the importance of
Microsoft Excel.

2. create a simple database using fields and record.

3. use sorting, filtering, and mathematical formulas to process data.

56—
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- .WhatiAreIDatabasesl?_ A

Imagine that you have a very large library full of books, and you want to find

it

a specific book quickly. If the books are scattered, this will be difficult. But if

they are organized and recorded in a table—such as book title, author name, \

shelf number—the task becomes very easy!

This organized table is what we call a database.

A database :is a way to store and organize large amounts of data and
information (such as students’ names, grades, and schedules)
on a computer, making it easier to analyze, search, and modify
the data.

Importance : Databases help us collect information about people, places,
or things and make it easier to manage them. For example, a
school uses a database to organize its students’ information,
such as student name and registration number.

Excel (Microsoft Excel): A Tool for Building Databases

We can use Microsoft Excel — the program in which you learned addition,
subtraction, sorting, and filtering, to create simple databases. Excel works with
tables made up of rows and columns.

Remember : In a database, a column is called a field, and it represents a
type of information (such as “Student Name »). A row is called a record,and
it represents complete information about one item (such as the data of one
student).

Steps to Create a Simple Database in Excel :

Let’s assume you want to create a database for the members of the reading

club in your class:

Step 1: Define the Columns (Fields)

@ In the first row (Al, B1, C1, ..), enter the necessary column headings.
These headings are called «field names».

@ Exemple :In cell Al, write «ID Number«.
@ In cell B1, write «Class Name «.

@ In cell C1, write «Student Namen.

Second Term @ -
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Step 2: Enter the Data (Records)

Start from the second row and fill in the data under each column.

Exemple :Under “ID Number” (Al), in cell A2, write the number (1111-11-
001).

— ® Under "Class Name" (B1) in cell B2, write “Grade 6/ B"'.
@® Under "Student Name" (C1) in cell C2, write « Ahmed Ali »

QUnit’H

Step 3 : Add New Columns (Insert Column)

@ If you want to add a new column 'such as ‘Date of Birth’'), right-click on
the header of the column where you want the new column to be inserted
before.

® Choose 'Insert Column'. A new column will be added and formatted
automatically.

@Calculations and Formulas in Excel
® Remember that Excel is an excellent program for performing calculations!
@ Golden rule: To create any formula, you must always start with the equals
sign (=).
Simple Examples of Formulas :
@ To add specific cells

@ To subtract cells

@ To calculate an average (addition then division)

N

Dear student... Using Microsoft Excel, create a simple database

for some of your classmates or friends.

- Primary 6
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; °
! General Questions
|

Qnit’ 4

[
| \
:.Aic_ho.os.e_th.e_c.o.m:e.ct_a.n swer_from_a, b, c, or d:

1. What is the most appropriate definition of a database?
A) A collection of stories
B) A way to store and organize large amounts of information
C) A program for creating presentations

D) A file for writing messages

2. In Excel, the row that contains complete information about one
person is called:

A) Field B) Record
C) Column D) Workbook
3. To add a new column in Excel, we use the option:
A) Delete row B) Insert column
C) Sort data D) Filter data

4. Programs such as Microsoft Excel are used to create and manage:
A) Daily notes B) Electronic games

C) Databases D) Animations

5. Which symbol must any calculation (formula) start with in Excel?

A) + B) - C) * D) =
6. What do we call a column heading in a database (e.g., “Student

Name”)?

A) Record B) Class

C) Field D) Workbook

7. When you enter column headings such as “ID Number” and

|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
I
|
|
|
|
|
|
|
|
|
|
I
|
|
|
|
|
|
| 13 i) e [
| Class Name”, you are typing in:
|

|

|

|

|

|

A) The second row B) The first row
C) The last column D) Any empty cell
Second Term
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| 8. One of the common tools that helps you organize data in Excel is:

QUnit’H

i A) Insert Picture B) Sort
i C) Add WordArt D) Draw a circle
_ ) i 9. If you want to calculate the sum of the numbers in cells C2, C3,
i and C4, what is the correct formula?
i A) C2+C3+C4 B) =SUM(C2-C4)
| C) =C2+C3+C4 D) C2C3C4
i 10. Storing databases for large amounts of information is done in:
i A) Radio B) Computer system
i C) Old telephone D) Photocopier
|

N

B\\ Put true (V) if the sentence is correct and false (X) if
~ Jthe sentence is incorrect:

1. When you use a formula such as B3 - B2=, you are performing a
subtraction operation. ()

2. The main goal of analyzing and modifying data is to destroy the
datA) ( )

3. When sorting data based on students’ ages from youngest to
oldest, we use the Sort tool. ()

Y. The program that uses tables made up of rows and columns to
create databases is WorD) ()

5. The first step in creating a simple database in Excel is identifying
and writing the column names (fields) in the first row. ()
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Lesson 6
Flowcharts (SmartArt)

Lesson,Objectives;:j) .

By the end of the lesson, the student will be able to:

1. identify the types of flowcharts (SmartArt).
2. insert a flowchart into a slide using SmartArt.

3. modify the flowchart (SmartArt) by changing colors, chart type,
etc.

Second Term m
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. .Whatiarelflowcharlts?_ A

Do you have a lot of information or steps and want to share them with

QUnit’H

your classmates in an easy and understandable way? This is the purpose of
e flowcharts (SmartArt).”

SmartArt : It is ready-made graphics and shapes in PowerPoint that
help you present information visually and in an organized
way, either as sequential steps or clear relationships (as
shown in the picture).

Importance : It makes your presentation more engaging and help
the audience (your classmates and teacher) understand
complex information or the steps of your project more
easily and quickly than reading long texts.

e Ildea:. /\/\ o

You can use SmartArt to illustrate the stages of a plant’s life cycle, the steps

for preparing a meal, or organizing a team for a project!

Steps to Insert and Customize SmartArt in PowerPoint:
We will follow these steps so that you can add a nice and suitable flowchart.

Step 1: Inserting

1 Click on the “Insert” tab located on the top tab of PowerPoint.

2 Look for the “SmartArt” icon and click on it. A dialog box will appear

showing many types of charts.

Step 2: Choosing the Type

1 Choose the type that best represents your information. If your information

consists of sequential steps, select from the “List”, “Cycle”, or“Process”
categories.

2 Click on the chart you prefer in the dialog box, then click “OK” to add it
to the slide.

- Primary 6
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Step 3: Adding Text

Qnit’ 4

1 Click on the “Text” or the “Flowchart” that appears on the slide.

2 Start typing the information or steps you want to explain inside the
designated boxes in the chart. \

Step 4: Customization and Beauty!
After inserting the text, you can make your flowchart more visually appealing:

1 Click on the chart. Two new tabs will appear at the top: “SmartArt

Design”and “Format.”

2 From “SmartArt Design”: you can choose “Change Colors” to make your
slides more attractive, or select a new style from the “SmartArt Styles”
to change the shape and appearance of the boxes.

With “SmartArt”, you don’t need to write long texts; you can share information

visually, which is the key to successful and effective presentations!

BracticallActivity): A\

Dear student... Create a slide in PowerPoint and insert a
SmartArt chart to present information in an organized and
attractive way.

Second Term -
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Lesson.6

General Questions

RN
:.A;C.h.o.o.s.e_th.e_co::r.ec.t_answ.e.r_f.r.om_a,_b.,_c,_oAr_d:

1. Flowcharts (SmartArt) are mainly used for:

A) Writing long texts
B) Simplifying and presenting a series of steps or information
C) Playing videos only

D) Performing mathematical calculations

2. To add a SmartArt chart to a slide, we start by clicking on the

tab:
A) Design
B) Insert
C) Review
D) Animations
. To represent the sequential steps of completing a project, it is
preferable to choose from the flowchart category:
A) Hierarchy
B) Relationship
C) Matrix

D) Process

. If you want to change the colors of a flowchart, go to the tab that

appears after inserting it, which is:
A) SmartArt Design

B) Font Format

C) Spelling Review

D) Slide Show

. PowerPoint provides the ability to insert:

A) Charts and videos
B) Calculators
C) Carpentry tools

D) Measuring devices

Primary 6
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6. Flowcharts help you understand the presented material better
than:

Qnit’ 4

A) Animations
B) Videos

C) Plain (written) texts —
D) Graphs

|

|

|

|

|

|

|

|

|

|

|

|

|

|

|

|

! 7. When you choose the “Change Colors” option for a chart, the

| purpose is:

|

! A) To make the flowchart attractive and colorful.

| B)To increase the font size.

|

! C) To delete the chart.

i D) To change the written texts.

| 8. After inserting the flowchart, you click on the [flowchart] to:

i A) Delete it.

i B) Add the text and information you want to display.

|

! C) Print the slide.

| D) Close the program.

|

! 9. Charts are used in PowerPoint to:

i A) Write poetry.

| B) Create transition effects.

|

! C) Represent data and numbers visually.

| D) Search for information.

|

' 10. Which tool can you use to represent the stages of the “life cycle”
' of something?

|

I A)List

i B) Relation

| C)Cycle

|

! D) Matrix

I
|
|
|
|
|
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Lesson.6

N\

B\\ Put true (V) if the sentence is correct and false (X) if
~ _the sentence is incorrect:

1. SmartArt diagrams are used in PowerPoint to display information in
a visual and organized way. ()

2. SmartArt cannot be inserted through the “Insert” menu in
PowerPoint. ()

3. The “Process” category in SmartArt is used to show sequential
steps. ()

4. After inserting SmartArt, its colors or design cannot be changed.

5. One of the benefits of SmartArt is that it helps the audience
understand complex information more easily and quickly. ()

= = = - — — ———————————— o ——— = — = — o —— —— — - - — o ——————— = ————— — — — (= =
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